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Preface

Some of you may be wondering why a teacher would
want to create a class Web Page. I can give you several
reasons why I decided to create one with my class as well
as why this manual was created. First of all, I am proud of
my class and want the talents of my students to be shown
off. Second, I was able to kill two birds with one stone. The
ability to integrate the Internet into the existing curriculum
has allowed me to fulfill two standards for the price of one.
Not only did I fulfill my technology standards for the fourth
grade, but I also fulfilled my biography standards for the
fourth grade in a way that the students found interesting.
Finally, I feel it necessary to immerse my students into
technology whenever appropriate and possible so that they
might be ready for the 21st century.

Technology has taken off in the classroom like a wild
fire. One would be hard-pressed to find a school without
either computers in the classroom or a computer lab in the
school. This infestation of computers in to the classroom is
only a microcosm of the real-world where computers have
invaded households, libraries, and businesses. Children in
the 90's are expected to know how to use, or at least be
familiar with and comfortable in front of a computer. Where
are these children going to learn about computers? Some



may answer that many families own computers and
therefore children can learn about them at home. What
then do we do with the children whose family can not afford
computers, or simply choose not to purchase one? The
schools have provided this answer by introducing
computers into the classroom.

You might now be thinking this is great for the student,
but what about me, the teacher? Well many states have
now passed computer competency requirements for
classrooms. Students must possess the computer skills
appropriate for that grade level in order to move on to the
next. We, as teachers, are in charge of teaching those
skills to the students. If we are not knowledgeable about,or
comfortable with computers, how can we expect to teach
our students these skills? The answer is we can not expect
to. This manual is created for those teachers with very
little or no technology experience. By simply following this
manual, you will possess the skills to create your own class
Web Page. When we combine computers and technology
with education, the result we get is students ready for the
technologically driven world that awaits them.

ii
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Introduction



Time to complete
this project will vary
by class and
teacher.

Planning your Web
Page before
creating it will save
lots of valuable
time.

Introduction

To help you create your class Web Page,
I will take you through the process step by
step in this manual. It is important to note,
though, that these steps need not be followed
in this order to complete your Web Page.
School circumstances and planning problems
may necessitate the rearrangement of these
steps. I would plan for this project to take
about 20 total hours, and have included a
time line in the appendix to follow if you would
like.

Thought processes

The first part of the manual will be
devoted to the thought processes preceding
the actual creation of your Web Page. It will

2
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Deciding the layout
of the page is one of
the most crucial
parts of creating
your class Web
Page.

Graphics can help
make the Web Page
interesting and
keep the viewer's
attention on it.

save time if you and your class know what
you would like on your Web Page before you
actually start creating it. The thought
processes preceding the creation of your
Web Page include looking at other Web
Pages, deciding what you want the theme of
your page to be, deciding what you want to
include in your Web Page, and deciding how
you want the page to be laid out. If you

complete these steps before you actually
begin creating your Web Page, you will save
yourself a lot of time.

Capturing images

The second part the manual will be
devoted to capturing images that you might
include in your Web Page. Most interesting
Web Pages have graphics of some kind.

3



Directions for how to
use the digital
camera, scanner,
and graphic
converter will follow
in this manual.

Creating the page is
perhaps the most fun
part of the project for
the children.

After you have determined what you would
like to use for graphics, this section of the
manual will show you how to capture and
convert your images so the images will be
available for your Web Page. Included in this
section are the digital camera, the scanner,
capturing images from other Web Pages, and
graphic converter.

Creating the page

I rk

The final section of this manual will be
devoted to the actual creation of your Web
Page. This manual concentrates on Claris
HomePage as the tool for creating your Web
Page. Once again I think that it is important to
note that this manual is created for those
educators with very little or no computer

4
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experience. Those teachers with more
advanced skills in computing, might not
benefit greatly from this manual.



Tips Before Creating Your Class Web Page

Make sure you know your school district's policy regarding the
World Wide Web. Many school districts do not allow the use of
names or pictures of students to be posted on the Web. An
example is included in the appendix.

Find out what resources your school offers. The creation of a
class Web Page might not even be possible if your district does
not have the resources to create one. Check with your school's
technology advisor before beginning.

What theme do you want for you Web Page? It is important to
give the students a reason for creating a class Web Page. If you
are currently studying ecosystems, you might choose to focus
your Web Page around that topic. Examples of possible themes
are included in the appendix.

What technologies do you want / need to include in the creation
of your Web Page? Many districts and states have computer
standards for each grade. Find out what the standards are for
your particular grade and try to include them in the creation of
your site.

Let the students have as much ownership and control over the
creation of the Web Page as possible. The more input and voice
they have in the creation of their project, the happier they will be
with the output.

Most importantly, have fun. The creation of your class Web
Page should be a fun experience for you and your students. It is
a chance to show the world, literally, what you and your students
are all about. If you find that you are not having a good time with
the creation of your class Web Page, step back and reevaluate.

Soon, your class will be
world-wide on the Internet.

6
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Thought
Processes



For safety
concerns, it is
best to bookmark
sites if the
children are going
to be looking at
them without
supervision.

Thought Processes

As I mentioned earlier, this section of the
manual is devoted to the thought processes
involved before you actually begin your class
Web Page. I have listed several steps to
follow when thinking about what you would
like for your Web Page, in the order I found
most useful.

1. Look at other Web Pages. This step is
important for brainstorming and gathering
ideas for what you would like in your Web
Page. It is also important that your students
know exactly what a Web Page is, and what it
is they are creating. This step works very well
if you have a television and a presentation
system so that everyone can view the Web
Pages at the same time. I would advise
browsing the internet yourself before letting
the students go off on their own. It might be

8
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Having a good
reason for your
kids on why you
ere doing aWeb
Page is
important.

wise to bookmark several sites on the net that
you would like the class to see. This avoids
children surfing the Web and finding things
they should not be seeing.

F SU GGE ST ION S

2. Decide what you want the theme of your
class Web Page to be. It is important to have
a reason for creating a class Web Page. Just
creating a page for the sake of technology will
not have as big an impact as having a reason
behind doing it. You can choose the theme of
your Web Page to be virtually anything, so
you can easily tie the creation of it in to your
curriculum.

3. After you have decided on a theme for
your Web Page, you need to decide what to

9
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Including student
wotic is crucial if
you went them to
have ownership
over the project.

This step of your
project should
move rather
smoothly if you
have followed the
steps to this
point.

include in it. For example, if you decide that
you want the theme of your Web Page to be
reptiles, you might want to include reports the
children have done, pictures the children
have either taken, created or captured, and
links to other pages focused on reptiles.

4. Finally, after you have decided what you
would like to include in your Web Page, you
will need to determine the layout of your Web
Page. Things such as where you want your
reports, where you want your pictures, where
you want your links, do you want to include
any tables or graphs, all come in to play
during this step. This step makes the actual
creation of your Web Page a breeze. Then
create your page.

10



Capturing
Images



Adding graphics
to your Web Site
greatly
enhances its
looks.

Mast all graphic
capturing
techniques ere
simple once
you have
learned the
basics.

Capturing Images

This portion of the manual is devoted to
capturing the images that you will be using in
your Web Page. There are several different
ways to capture images to use with your Web
Page. Instructions for the most complicated
ones will follow this page.

1. The Quick Take camera. This digital
camera is available in most schools for
checkout and is very simple to use.
Directions for its use are on the following
pages.

07000
OWSarom
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2. The scanner. Almost all schools own a
scanner that can be used by the teacher, and
students under teacher supervision.
Directions for scanner use will also be
included on the following pages.



Make sure you
understand the
copyright laws
end 'Yak use"
policies.

3. Capturing images from other Web
Pages. Capturing images from other Web
Pages is very simple. For an IBM, you click
on the right mouse button when it is on the
image and choose "Save image as". For a
Macintosh, you hold the mouse button down
when it is on the image and then choose
"Save image as".

Most images can be captured and used
for personal pages not involving any sort of
advertising or sales. However, there are
copyright restrictions on many of the images
you will find on the Web, and there are many
people and companies that do not like people
using the images they have created. It is

always safest to email the owner of the Web
Page (the email address can usually be found
on the bottom of the page) and ask for
permission to use the image in your class
Web Page.

13
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If you do not use
Graphic Converter
your images will not
show up on your
Web Page.

4. Graphic Converter. Graphic Converter is
a computer program that allows you to
convert images you have captured so that
they may be used in your Web Page. Most
schools own graphic converter and directions
for its use are contained on the following
pages.



If you can use a
normal camera,
then you can use
adigitei camera.

Many districts do
not allow student
pictures on the
Web.

Quick Take Digital Camera

Introduction

As mentioned earlier, the Quick Take
digital camera is one way to get photographs
onto your Web Site. The digital camera is a
camera which uses no film, but rather stores
the pictures you take in memory until they are
downloaded onto your computer. Although
this may sound complicated to the novice
computer person, the use of a digital camera
is as simple as your normal camera. Simply
aim and shoot.

Use
The Quick Take camera is ideal for taking

pictures of your class or individual students
for your Web Site (again, check on your
district's policy regarding student pictures on
the World Wide Web). The Quick Take

15
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If your school does
not have a digital
camera, check with
the technology
specialist about
acquiring one.

camera can also be used to capture class
projects, students in action, and anything your
normal camera can capture. The advantage
is you get immediate feedback of your
pictures and do not have to spend money to
get your pictures developed. Most schools
will have a digital camera available for you to
check-out. Instructions on how to use the
QuickTake camera will follow on the next
page.

16
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Quick Take Digital Camera

Using the Camera:
1. Slide the lens cover to the side to turn the camera on.
2. Check the display screen in the back of the camera to see the number of pictures

taken so far. If pictures have been taken, use a pencil or pen to press the button
on the lower left side of the display screen to delete those pictures.

3. Check the upper right part of the display screen to see how many pictures can be
taken, for use with a home page you should be able to take 32 pictures. If the
upper right of the display says you can only take 8 pictures, then press the
button on the upper right side of the display. This should change the camera so
you can take 32 pictures.

4. To take a picture, press the button on the top of the camera just like you would with
a normal camera.

Getting the Pictures from your Camera
to the Computer Screen:

1. Plug the power adapter (should come with camera) into the side of the camera and
into an power outlit.

2. Connect one end of the cable (this should come with the camera) into the side of
the camera.

3. Connect the other end of the cable to the back of the computer into the modem port
(this will have a picture of a phone over it).

4. Turn the camera on by sliding the lens cover over.
5. Using the mouse, click on the "Quick Take Image Access" icon or button.
6. When the new screen comes up, click on the "Connect to Camera" button.
7. An icon (or picture) of a camera should appear on the screen. Open the camera

icon by double clicking on it.
8. Your pictures should show up as icons on the screen. If you wish to look at your

pictures before saving them to disk, double click on the picture you wish to see.
9. Save the pictures you want to keep to your disk by clicking on the picture (be sure

to hold the mouse button down) and dragging the picture to your disk icon
(the picture of your disk on the computer screen).

To use these saved pictures in your home page, go
to the directions for Graphic Converter.

17
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Almost every
school has at
least one scanner
for teacher/
student use.

Many pictures are
copyrighted and
you will need
permission to use
them.

Flatbed Scanner

Introduction

1.e0405"/ 'Tetalitvw-a
/maw=

The scanner is yet another way to get
graphics onto your Web Page. The scanner
is like a photocopier for your computer. You
can place any picture, drawing, graphic, etc.
that you would like onto the scanner, and it
will photocopy it on to your computer. Once
you know the basics about using a scanner, it
is just as easy as using a photocopier. Simply
lay your sheet down the way you want it, and
scan.

Use
The scanner is ideal for putting pictures

that your students have drawn, taken, or
found in magazines, on to the Web Page (if
you use pictures from a magazine, make sure
that they are not copyrighted). The

18
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Putting student
artwork on the Web
Page will give them
more ownership
over the project.

advantage of the scanner is that you might
already have pictures that you have taken
with a regular camera that you want to include
on the Web site. This eliminates the need to
retake a picture with the Quick Take camera.
Another advantage is the ability to show off
student art work on the Web. The scanner
allows you to put pictures of original student
artwork on the Web, without having to use a
computer program to recreate it. Most
schools will have a scanner available for you
to use. Instructions on how to use the
scanner will follow on the next page.



Scanning Directions

Using the Scanner
1. Use the mouse to click on the "Ofoto 2.0" icon or button (there might be a picture

of a scanner like the one below).

2. Place the material you want to scan onto the glass scanning surface, face down
(think of a scanner as a photocopier for your computer. The way you place your
material on the scanner is the same way that it will appear on the screen. If you
place a picture upside down on the scanner, it will appear upside down on the
screen).

3. Once "Ofoto 2.0" has been opened, you will see a window called "scan controls" on
the screen. At the top right of this screen, you will probably see the words
"Apple Color Prtr" as the calibration. You want to change the calibration to
"Apple Color Display". Do this by clicking your mouse on the words "Apple
Color Prtr" and changing it.

4. You can skip this step if you would like, but it might end up saving you time. Click
on the words "Pre-Scan" on the bottom right of the "scan controls" window.
This will do a quick scan of the image to make sure that it is positioned correctly
in the scanner. When this is complete, a dotted line will appear around the
picture. Use the mouse to drag this dotted line around the exact part of the
picture that you want scanned. This will allow you to get rid of parts of the
picture you don't want.

5. Click the "Scan" button. If you skipped step 4, then click the "Auto-Scan" button.
6. You should now see an image of your picture on the screen.
7. To save your picture, go to the "File" menu and select "Save As". You will need to

name your file as well as select a place for it to be saved to.

To use these saved pictures in your home page, go
to the directions for Graphic Converter.

20
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Without converting
your graphics from
a PICT format to a
GIF orJ PEG
format, you will not
be able to see your
graphics on your
page.

Graphic Converter

warmwssawaillifill

AA.......

Introduction

Graphic Converter allows you to use the
graphics you have saved on your Web Site.
Each object that you use must either be
saved in a format called GIF, or JPEG. Under
normal circumstances, the graphics that you
collect either from your digital camera or
scanner, will be saved in a format called
PICT. Files saved under the PICT format will
not be able to be used on your Web Page.

Use
As previously mentioned, Graphic

Converter is necessary in order to use the
majority of your graphics on your Web Page.
Without Graphic Converter, your digital
camera and scanner would be virtually

21
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Not only does
Graphic Converter
change your images
so that they can be
read, but it can also
be used to save
memory.

useless as means to get graphics on your
Web Page. It is advisable to open all the
graphics that you plan to use in your Web Site
in Graphic Converter. This will assure that all
graphics will be in the correct format to use.
In order to use your graphics you need only
make one change, however in order to
decrease the amount of memory used,
several changes are advised. Most schools
will have the Graphic Converter software.
Graphic Converter is shareware, though, so if
your school does not own it, you can obtain it
for free.

22
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Graphic Converter

Using Graphic Converter

1. Click on the "Graphic Converter" icon.
2. Go to the "File" menu and choose "Open". Then find the file that you want to open.

(You might have to click Desktop in order to find your disk with the file on it.
3. You should now see your picture on the computer screen.

Converting your Picture

1. Once your picture is opened, you need to change its resolution to 72 DPI. to do
this, you need to go to the "Picture" menu and choose "Resolution".

2. Make sure the horizontal and vertical dpi is 72.
3. Next you should change your colors to 256 Colors. To do this, go to the

"Picture" menu and choose "Colors".
4. Drag the mouse down to 256 Colors (8 Bit).
5. When you have done this, go to the "File" menu and choose "Save As".
6. In the "Save As" window, change the Format to GIF (this is the most crucial

step!) and save your file to your disk.

You are now ready to use your pictures and graphics
on your web site!

23
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Web Page
Layout



You will quickly find
that you will went to
save as much time
as possible. This is
one area where a lot
of time can be
saved.

Web Page Layout

title

text image

text

image

Introduction

After you have decided what to include in
your Web Page, and have captured all the
images you wish to use, the next step is to
plan what your site will look like. I found this

to be a very crucial step in the creation of the
Web Site with my class. Not only do I feel that
it saved a lot of time, but I also think it saved a
lot of class arguments about what to put
where once we started the actual creation of
the page.

31

25



If you physically lay
out your Web Page
before trying to
create it on the
computer, it
becomes a breeze
and avoids student
arguments.

There are many
instances while you
are creating your
Web Page that you
can get two lessons
in at the same time.

I have included, following this page,

some sheets that you can cut out and use to
physically layout your page. I found it useful
to use a felt board when planning the page so
that everyone in the class could see what was
happening. I also recommend using a
democratic way (majority rules) of choosing
what images and text go where. The more
dictator-like your position is in creating the
page, the less fun the project will be for the
students, and the less ownership they will feel
over "their" class Web Page. Using a
democratic way of deciding the layout of the
page avoids much conflict and arguments. It

might be useful to explain the democratic way
to some younger students so they understand
that this is the way the United States is run for
the most part (this way you will get a little
history and government mini-lesson in at the
same time).

26
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It may seem like you
ere spending a lot of
time on this part of
the project, but it will
save time down the
mad.

Don't be surprised if this step in the
process takes a large amount of time.
Spending adequate time on this step, will
allow for the smooth creation of the page
when you finally go to actually create it using
Claris HomePage. Having the physical layout
of the page will allow you to let students go to
the computer and work on it alone, knowing
that they will know what goes where and what
the page will look like. It will free up time for
you in the long-run.



Title

image

image

image

image
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Creating Your
Web Page



Creating your Web Page using
Claris Home Page

This manual concentrates on the use of Claris Home Page in
the creation of your class Web Page. I think that you will find Claris
Home Page extremely user friendly, and that after you have
planned how you would want the Web Page to look, the creation of
it will be a breeze. Using Claris Home Page is a lot like using
Claris Works in its simplicity.

Text
For text, you simply type and then choose a size, style, and

font for your text. I have included a graphic below which will show
the buttons in Claris Home Page which control the size, style, and
color of your text. To change the font, use the "Style" menu.

Normal

These buttons control the
size of your words. The a+
button increases the text
size, and the a- button
decreases the text size.

This button allows
you to change the
color of your text.

These buttons will change
the style of your text to bold
or italic. To change to
another style, go the "Style"
menu and change it there.

Other options in terms of your text, include having a bulleted list, a
numbered list, centering your text, and aligning your text to the
right. The buttons for these purposes will be shown below.

These buttons create
either a bulleted list or
a numbered list.

These buttons will align your
text to the left, center, or right
as desired.

d
3

'Normal V Is
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Images
To insert images into your Web Page, choose the "Insert"

menu. Under the insert menu choose the option "image..."
After this you will need to find the image that you wish to insert
and then open it. Your image should then appear in Claris
Home Page, provided that you have saved it in a GIF or JPEG
format (see Graphic Converter).

Insert Format Styl

Anchor...
Link to URL...
Link to File...
Image...
Horizontal Rule
Table
App let
Quick Time Movie...
Plugin...
Forms

List
Line Break

From Library NY

This option will allow
you to insert images
into your Web Page.

Inserting images into your Web Page is
as simple as that. You can then change
the size of your image by clicking on it
once and then dragging a corner of it until
you have the size desired. However,
changing the size of an image once in the
document will alter the quality of the
image. It is best to change the image to
the size you want in Graphic Converter.

Links
To insert a link into your Web Page,

you need to highlight the text or picture
that you would like to change to a link,
and then go to the "Insert" menu again
and choose either "Link to URL..." or
"Link to File..." If you want to link to a
Web Page that is already on the
Internet, you should choose "Link to
URL..." and then enter the address
when prompted. If you wish to link to
another Web Page that you are creating
that has not been uploaded onto the
Internet, you should choose "Link to
File..." and enter the file name when
prompted. 32
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( Use Defaults ) ( Cancel )

Backgrounds and Colors
Many Web Pages have unique background patterns other

than just solid colors. In this section I will tell you how to change
not only your background, but also the colors of links and text. To
change the color of your text, links, and background, choose the
"Edit" menu.

Buis insert r corm' sigue
Undo a2

Cut
Cop
Paste
Clear
Select All

f.2 II

WC.

MU

39 0

Document Options...
Document Statistics...

8J
MK

Find/Change...
Find Neat

Check Spelling...
Check Selection...
Select Dictionaries...
Edit User Dictionary...

MF
NG

X=

Preferences...

Basic

Tent:
Background:

Once in the "Edit" menu, choose
"Document Options..." This should
get you to the screen at the bottom
of the this page

Changing the color of your text,
links, and background is self-
explanatory from this point. To
change your background to a
pattern, choose the "Set" option next
to "Background Image." You will
need to have a pattern saved onto
your disk (see the section on
capturing images from the web).

Normal nk:
Uisit Link:

Background Image: Set... ( None )

Rctiue Link:

Document Title:

Color of the page background (only used if no background image is specified, or if the
browser user has disabled image loading).

( OK
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Tables
Something I found very useful in the creation of my class

Home Page were tables. Tables are very convenient for
organizing information. For example, my students each had four
pieces of their work displayed on the Home Page which were
arranged neatly in a 2 X 2 table like the one shown below.

ee as

You can neatly fit four
pieces of student work
into this table.

For my particular class page, the students included a biography
that was done by a classmate, a description of themselves in
about 25 words, a picture that they either scanned in or took
using a digital camera, and a KidPix picture they created. The
table organized each student's material neatly.

Tables can also be used to frame pictures as shown below. If you
choose a 1 X 1 table, it will form a nice frame that you can insert a
picture into.

di

I
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This table forms
a nice frame for a
single picture.



Uploading
Your Web

Page



This is one of the
most important and
most tricky steps in
the process
because it will very
from server to
server. Check with
your technology
specialist if you
have questions.

The information you
need to upload your
Web Page is the
same information
you need to check
email.

Uploading Your Web Page

After you have created your Web Page,
there is only one thing left to do, upload it onto
the Internet. The most important part of this
process is to initialize your account. Because
this process is different for different servers,
check with your technology specialist to
determine what you need to do at this point.
Once you have initialized your account you
are ready to upload your Web Page from your
disk. To do this you will need to use a
program called "Fetch". Most schools will
either have this program or will get it for you.

Once in "Fetch" you will need to enter the
host you are connecting to, your Login ID,
your password, and the directory you want to
upload your page to (just like logging in to
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Again, this will vary
from server to
server, so I suggest
using the services of
your technology
specialist.

your email account). In most cases, the
directory you want to load your page to will be
"public_html". Once you have done this and a
connection has been established, you will
need to go to the "Remote" directory and
choose "Put Folders and Files...." Once in
that screen, choose "Add all", and then
choose "Done". At this point you make sure
that "text files" are being uploaded as "text",
and "other files" are being uploaded as "raw
data". Next, choose "ok". This will upload
your Web Page onto your account and you

should now be able to access it on the

Internet.
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APPENDIX A

Time line of Events

Lesson 1 : Introduction to Web Pages
* Themes
* Likes and dislikes
* What you want to include

Lesson 2-4 : Introduction to the Digital Camera
* What it is
* How to use it
* How to download images from it

Lesson 5-6 : Introduction to the Scanner
* What it is
* How to use it

Lesson 7-8 : Introduction to Graphic Converter
* What it is
* How to use it

Lesson 8 : Capturing images from the Internet
* How to do it
* Copyright restrictions

Lesson 9-11 : Web Page Layout
* Plan a layout for your page

Lesson 12-20: Introduction to Claris HomePage
* What it is
* How to use it

Lesson 21 : Uploading your Web Page
* How to do it



APPCNOtX e.

File: IIBE

ACCEPTABLEUSBDFTECHNOLOGY

Internet and computer network and non-network access is available to authorized students,
teachers and other staff in the Albemarle County Public Schools. The goal of the Albemarle
County Public Schools in providing this service is to promote educational excellence by
facilitating resource sharing, innovation and telecommunications as outlined in this policy and
applicable regulations.

With the access to world-wide resources made possible through technology comes the
availability of material that may not be considered of educational value in a school setting. All
reasonable precautions are to be taken by teachers and other staff to restrict access to
educationally inappropriate materials.

Use or transmission of any material in violation of any United States or state law is strictly
prohibited. Also prohibited are the use or transmission of the following: material protected by
federal or state intellectual property laws; copyrighted material; licensed material; threatening,
harassing or obscene material; and/or pornographic material. In addition, it shall be prohibited
to access, attempt to access, use, or attempt to use the Internet, or other computer network or
non-network facilities, for any other unauthorized purposes, including but not limited to
commercial activities, introduction of viruses, manipulation or corruption of systems, files and
other related resources.

Use of the Albemarle County Public Schools' Internet and computer facilities is a privilege, not a
right. Inappropriate use will result in an immediate termination of access and other privileges
relating to use, and may also result in disciplinary action (up to and including suspension or
expulsion in the case of students) as well as potential civil or criminal liability and prosecution.
lnappropropriate use will result in an immediate termination of access and other privileges
relating to use, and may also result in disciplinary action (up to and including formal reprimand,
suspension or dismissal in the case of staff) as well as potential civil or criminal liability and
prosecution.

Before using the Internet and computer facilities, students, teachers and staff shall meet with
the building principal or designee, or other appropriate staff member to review this policy, learn
about appropriate use of Internet and computer resources and become familiar with the
protocols of using the Internet and computer facilities. In addition, students and/or their parents
or other legal guardians shall, prior to the beginning of the school year or as soon as
practicable, receive and sign an acknowledgment of this Policy and return same to the
appropriate individual school(s). Teachers and staff members shall also receive an
acknowledgment of this Policy and shall indicate in writing to their respective supervisors that
they have read, understood and agreed
to its terms.

Administration, faculty or staff may request that the systems administrator deny, revoke or
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suspend specific user access in the event of violation of this policy.

Adopted: August 26, 1996

File: IIBE-R

ACCEPTABLEUSIDFTECHNOLOGY

Use of the Internet

Through the Internet, students in the Albemarle County Public Schools have access to a variety
of resources, including:

1. World-wide electronic mail.

2. Library catalogs from around the world, including the Library of Congress.

3. "Virginia's PEN", Virginia's Online Public Education Network.

4. The World-Wide Web, a collection of Internet Resources.

Liability

1. The Albemarle County Schools will not guarantee the availability of access to the Internet and
will not be responsible for any information that may be lost, damaged, or unavailable due to
technical or other difficulties.

2. The accuracy and quality of information obtained cannot be guaranteed, nor can information
sent or received be assured to be private.

3. The Albemarle County Schools cannot control or censor illegal, defamatory, or potentially
offensive materials which may be available to the user on systems accessible through the
Albemarle County Public Schools.

Responsibilities of School Staff

1. Staff members assigning student Internet use will pre-screen network resources in order to
determine which are applicable to the curricular needs of the assignment and the appropriate
developmental level of the student.

2. As in any classroom situation, the teacher is responsible for the supervision and monitoring
of learning activities.

3. Access to Internet resources will be protected by "staff only" passwords with a staff member
present.
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4. Staff members assigning or permitting Internet use will provide or arrange for instruction in
acceptable use of the Internet based on materials provided by The Department of Information
Services. Topics to be addressed include:

a. Content of the Albemarle County Acceptable Use of Technology Policy and Acceptable Use of
Technology Regulation

b. Generally accepted rules of network etiquette

c. Copyright issues

d. Privacy issues

e. Safety guidelines on the Internet

f. Respect for time and resource use

g. Making appropriate judgments about locating and using information which matches the
learner's instructional level and the learning objectives of the assignment

h. Discriminating among types of information sources and assessing the appropriateness of
using the Internet as a resource for a specific learning activity.

5. All Albemarle County staff members with active accounts on Virginia's PEN have the
opportunity, with appropriate training and guidance, to publish Internet home pages as a
participant in Albemarle's Anthology Project. Each school shall appoint at least two staff
members with active accounts on Virginia's PEN to be trained to serve as building-level
Anthology curators. All Internet home pages shall be reviewed at the building level by the
principal or designee and are subject to the terms outlined in Virginia's PEN's Acceptable Use
Policy in addition to those indicated here. Internet home pages shall include, at most, students'
first names and last initials. Individual student pictures are not allowed to be
posted on Virginia's PEN. Internet home pages shall be stored in a location assigned by a
designated curator following established transfer and naming protocols. Information and
materials (including links) contained in any home page residing in Albemarle's Anthology
pavilion on Virginia's PEN must be appropriate and relevant to the curriculum. Individual student
projects may be published, within an appropriate teacher's Anthology directory, as Internet home
pages when appropriate and feasible given disk space and other limitations.

6. No one may use Albemarle County Public Schools software or equipment to access any
service for which there is a fee, to conduct any purchase or to participate in any other
commercial activity without prior authorization of the building principal.

7. All Virginia's PEN activities are subject to the terms outlined in Virginia's PEN's Acceptable
Use Policy in addition to those indicated in this policy. As indicated in Virginia's PEN's
Acceptable Use Policy, a standard Virginia's PEN account shall only be used by the person to
whom the account was issued. Class accounts may be used by students under the direct
supervision of the person to whom the account was issued.
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8. It is the responsibility of the teacher to inform students of the expectations and responsibilities
associated with Internet use with respect to appropriate learning activities and to monitor this
use.

Student Responsibilities

1. Students will access the Internet with hardware and software owned by the Albemarle County
Public Schools under direct supervision of a staff member.

2. The student is responsible for using the school access provided in an ethical, responsible,
and legal manner for school-related tasks only. All other division and school codes of conduct
apply.

3. The following rules apply for all student access to and use of the Internet and computer
facilities:

a. The Internet will be used in Albemarle County Public Schools for school-related academic
activities only.

b. Students will access only those network resources to which they have been directed by a staff
member.

c. Students are responsible for their actions on school computer networks and any other
network accessed through the school network just as they are in any school setting.

d. Students will use appropriate language and follow all applicable codes of conduct.

e. The school division reserves the right to review the content of all computer accounts and files.
Network administrators may review files and communications to keep the network working
properly and to ensure that users are using the system responsibly. Users should not expect
that files will be private.

f. Users will comply with the Internet and Computer Use Acknowledgment they have signed.

g. Using or importing (transferring in) offensive, obscene, libelous, disruptive, or inflammatory
language, pictures, or other material on any computer or network within Albemarle County Public
Schools are prohibited.

h. Any harassment encountered on the Internet shall not be responded to and shall be reported
to the supervising teacher immediately. The teacher shall then report the incident to the building
principal who will report it to the Assistant Superintendent for Support Services.

i. Students with access to personal online accounts, such as America Online, CompuServe, etc.,
may not access these accounts using Albemarle County Public Schools software or equipment.
No student may use Albemarle County Public Schools software or equipment to access any
service for which there is a fee, to conduct any purchase or to participate in any other
commercial activity.
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j. For safety reasons, students shall not reveal home phone numbers, addresses, or other
personal information. Messages shall be signed using only a first name and last initial unless
participating in a moderated learning activity which requires full names. Electronic messages
shall be transmitted via the Internet with direct teacher supervision using an appropriate
electronic mail account.

k. Students will respect the privacy of e-mail and will not re-post communications without
consent of the sending party.

I. Students will use the Internet for legal activities only. Illegal activities include, but are not
limited to: knowingly spreading viruses, violating copyright laws, using unauthorized software,
impersonating another user, unauthorized entry, and/or destruction of computer systems and
files.

m. Students will use the network in such a way that use of the network by other users is not
disrupted. Network users shall be expected to respect all forms of password protection and use
responsible file management techniques (saving, deleting, naming, etc.).

n. Students will use all resources on the Internet in accordance with the policies of the
institutions providing the service and the procedures developed by Albemarle County Public
Schools.

o. Students may not participate in any form of on-line "chain letters" or the like, including
unmoderated surveying of mailing lists or user groups.

Consequences of Unacceptable Use

The use of the Internet is a privilege, not a right. Misuse of Internet access or a violation of this
regulation may result in the account or the student's access privilege being denied, revoked, or
suspended. Misuse may also subject the student to disciplinary action up to and including
suspension and expulsion. In addition, any illegal activities will be reported to the appropriate
agencies.

Acceptable Use of Technology Policy
Acknowledgment

I have read the Albemarle County Public Schools' Acceptable Use of Technology Policy and state
that I fully understand and agree to abide by its requirements in all respects. Should I violate any
aspect of this Policy, I specifically agree that I shall accept and be subject to all
ramifications, including but not limited to the loss of access and other privileges.

Student or Staff Member Signature
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Parent's/Legal Guardian's signature (for students)

Date

NOTE: YOUR SIGNATURE ON THIS ACKNOWLEDGMENT IS
BINDING AND ESTABLISHES THAT YOU HAVE READ THE
TERMS AND CONDITIONS OF THIS POLICY AND
UNDERSTAND THEIR SIGNIFICANCE.
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APPENDIX C

Possible Themes for your Web Page
Science:

Ecosystems
Solar System
Animal groups (ex. reptiles)
Genetics

English:
Poetry
Biographies
Book Genres
Fantasy Stories
Science Fiction

Humanities:
Wars
Eras
Politics
Democracy
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Math:
Fractions
Problem of the Week
Riddles

* *
.**,.***irir

frit*Crir*It;t1r*
* ** * +

Art:
Drawings
Computer Drawings
Paintings
Eras of Art
Genres of Art
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